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1 Introduction

Safety precautions

c
L
3=
o
S
k
S
S
£

The following precautions ensure the proper use of the printer and prevent
the printer from being damaged. Follow these precautions at all times.

e Use the power supply voltage specified on the nameplate. Avoid
overloading the printer's electrical outlet with multiple devices.

e Ensure the printer is well-grounded. Failure to ground the printer may
result in electrical shock, fire, and susceptibility to electromagnetic
interference.

e Do not disassemble or repair the printer yourself. Contact your local
HP Service Representative for service, see Contact HP Support

on page 63.

e Use only the electrical cord supplied by HP with the printer. Do not
damage, cut, or repair the power cord. A damaged power cord has risk
of fire and electric shock. Replace a damaged power cord with an HP-
approved power cord.

e Do not allow metal or liquids (except those used in HP Cleaning Kits)
to touch the internal parts of the printer. Doing so may cause fire,
electric shock, or other serious hazards.

e Power OFF the printer and unplug the power cable from the power
outlet in any of the following cases:

e When placing your hands inside the printer
e If there is smoke or an unusual smell coming from the printer

e If the printer is making an unusual noise not heard during normal
operation

e A piece of metal or a liquid (not part of cleaning and maintenance
routines) touches internal parts of the printer

e During an electrical (thunder/lightning) storm

e During a power failure.

ENWW Safety precautions 1



HP Start-Up Kit

The HP Start-Up Kit is the CD or DVD that comes with your printer; it
contains the printer's software and documentation, including introductory
multimedia tutorials to help you to get a good first print.
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%/;9 NOTE The HP Start-Up Kitis provided on CD in Japan, and on DVD
- elsewhere in the world. The rest of this guide will refer to the DVD
version only.

The front panel

Your printer's front panel is located on the front of the printer, in the center.
It has the following important functions:

e Assists you in troubleshooting issues

e Is used to perform certain procedures, such as cutting and unloading
paper
e Displays helpful animations to guide you through procedures

e Displays up-to-date information about the status of the printer such as,
the ink cartridges, the printheads, the paper, and the print jobs

e Displays warning and error messages, when appropriate, along with
audio alerts to call attention to a warning or message

e Can be used to change the values of printer settings and thus change
the operation of the printer. However, settings in the front panel are
overridden by settings in the printer drivers, see Using your printer on

2 Chapter 1 Introduction ENWW
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The front panel has the following components:

1.

10.

Direct access keys:
e First key: View ink levels, see Using your printer on DVD
e Second key: View loaded paper, see Using your printer on DVD

e Third key: Unload paper, see Unload a roll on page 18 and
Unload a single sheet on page 27

e Fourth key: Form feed and cut, see Using your printer on DVD

Menu key - Press to return to the main menu of the front-panel display.
If you are already on the main menu it will display the status screen.

OK key - To confirm an action while in a procedure or interaction. To
enter in a submenu in the menu. To select a value when given an
option.

Back key - To go to the previous step in a procedure or interaction. To
go to the upper level, or leave the option in the menu, or when given
an option.

Down key - To go down in a menu or option, or to decrease a value,
for example when configuring the front-panel display contrast or the
IP address.

Up key - To go up in a menu or option, or to increase a value, for
example when configuring the front-panel display contrast or the IP
address.

Cancel key - To abort a procedure or interaction.

Power key - To turn the printer off or on, it also has a light to indicate
the printer's status. If the power key light is off the device is off. If the
power key light is blinking green, the device is starting up. If the power
key light is green on, the device is on. If the power key light is amber
on, the device is in standby. If the power key light is blinking amber,
the device needs attention.

LED light - Indicates the printer's status. If the LED light is solid green,
the device is ready. If it is flashing green, the device is busy. If it is solid
amber, there is a system error. If it is flashing amber, the printer needs
attention.

Front-panel display - Displays error, warnings, and information on
using your printer.

The front panel 3
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To highlight an item in the front-panel display, press the Up or Down key
until the item is highlighted.

To select an item in the front-panel display, first highlight it and then press
the OK key.

When this guide shows a series of front-panel display items like this:
Item1 > Item2 > Item3, it means that you should select Item1, then
select Item2, then select Item3.

Information about specific uses of the front panel can be found throughout
this guide.
Printer software

The following software is provided with your printer:
e The PCL3 raster driver, your main printer driver

e The HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS),
see Access HP Easy Printer Care (Windows) or HP Printer Utility (Mac

OS) on page 7, allows you to:

e Manage the printer including color with the HP Color Center

e View the status of the ink cartridges, the printheads, and the paper
e View job accounting information, see Using your printer on DVD

e Update the printer's firmware, see Update the firmware
on page 41

e Change various printer settings (in the Settings tab)

E}/}’ NOTE Windows XP Professional x64 Edition does not support
= HP Easy Printer Care, therefore it cannot be installed with your
printer's installer.

e The Embedded Web Server, runs in the printer and enables you to use
a Web browser on any computer to perform the HP-GL/2 Upgrade and
to check ink levels and printer status, see Access the Embedded Web
Server on page 7.

e TheRTL and HP-GL/2 driver for Windows, needed if you have the HP-
GL/2 Upgrade

4 Chapter 1 Introduction ENWW



2 Personalizing the printer

Turn printer on and off

.

:{P_ Tip The printer is Energy Star compliant and can be left powered
+$+ on without wasting energy. Leaving it on improves response time
and overall system reliability. When the printer has not been used
for a certain period of time (30 minutes by default), it saves power
by going into sleep mode. However, any interaction with the printer's
front-panel display returns it to active mode, and it can resume
printing immediately. To change the sleep mode time, see Using
your printer on DVD.

E’/}’ NOTE In sleep mode, the printer wakes up from time to time to do
= maintenance service to the printheads. This avoids the need of
doing long preparation after long idle periods.

The printer has three levels of power consumption.
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e Plugged in: the power cord is plugged into the back of the printer

e Switched on: the switch at the back of the printer is in the on position
e Powered on: the Power key on the front panel shows a green light

If you wish to turn the printer on or off or reset the printer, the normal and
recommended method is to use the Power key on the front panel.

O

However, if you plan to store the printer indefinitely or the Power key does
not seem to work, you are recommended to power it off using the Power
key, and then also switch off the power switch at the rear.

ENWW Turn printer on and off 5
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When the printer is powered back on, it takes about three minutes to
initialize and check and prepare the printheads. Preparing the printheads
takes about one minute and 15 seconds. However, if the printer has been
off for six weeks or more, preparing the printheads could take up to 45
minutes.

|

_Q'_ Tip ltis strongly recommended to leave the printer powered on or
-5~ in sleep mode to avoid wasting ink and time.

6 Chapter 2 Personalizing the printer ENWW



Access HP Easy Printer Care (Windows) or HP Printer
Utility (Mac OS)

HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) enables
you to manage your printer from a computer with a USB connection and
TCP/IP.

e Under Windows, start HP Easy Printer Care from your desktop
shortcut or from Start > All Programs > Hewlett-Packard > HP Easy
Printer Care > Start HP Easy Printer Care. This launches HP Easy
Printer Care showing the printers installed.

e Under Mac OS, launch the Mac Printer Utility by selecting
STARTUP_DISK > Library > Printers > hp > Utilities > HP Printer
Utility. This launches the HP Printer Selector where you need to add
your printer by clicking More Printers.

Select your printer and click Launch Utility. This launches the HP
Printer Utility.

If you have followed these instructions but failed to get through to HP Easy
Printer Care (Windows) or HP Printer Utility (Mac OS), see Using your
printer on DVD.

Access the Embedded Web Server

ENWW

The Embedded Web Server enables you to manage your printer remotely
using an ordinary Web browser running on any computer.

r_f/r NOTE To use the Embedded Web Server, you must have a TCP/
= IP connection to your printer.

The following browsers are known to be compatible with the Embedded
Web Server:

e Internet Explorer 5.5 or later, for Windows
e Internet Explorer 5.1 or later, for Mac OS X
e Netscape Navigator 6.01 or later

e Mozilla 1.5 or later

Access HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) 7
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e Mozilla Firefox 1.0 or later
e Safari

To access the Embedded Web Server on any computer, open your Web
browser and give the address of your printer. You can find out the address
of your printer (starting with http:) from the front-panel display, by looking
at the status screen.

Eeady for paper

hitp: /7 mnKKll
http://192.168.1.1

Fress B to enter ﬁ L
men P
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If you have followed these instructions but failed to get through to the
Embedded Web Server, see Using your printer on DVD.
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3 Paper handling

Choose which spindle to use

Ensure you use the correct spindle. The illustrations in the Load a roll onto
the spindle on page 9 procedure and the Load a roll into the printer

on page 12 procedure show the black spindle. You must use the gray
spindle if you are loading the following categories and types of rolled papers
wider than 36 in (91.5 cm).

Paper category Paper type

Bond and Coated Paper Plain Paper

Bond and Coated Paper Bright White Bond Paper
Bond and Coated Paper Coated Paper

Technical Paper Natural Tracing Paper
Technical Paper Translucent Bond
Technical Paper Vellum

+ change rolls more quickly if you preload rolls of different paper types
on different spindles. Extra spindles are available for purchase,
see Accessories on page 43.

_‘{}' Tip If you are a regular user of different paper types, you can

(=)}
£
T

c

©
K=

S

[

Q.

©
o

Load a roll onto the spindle

A WARNING! Ensure the sheet tray is closed.

ENWW Choose which spindle to use 9
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1. Remove the right-hand end of the spindle from the printer, then the
other end.

WARNING! Do notinsert your fingers into the spindle supports
during the removal process.

2. The spindle has a stop at each end to keep the roll in position. The
blue stop can be removed to mount a new roll; it slides along the
spindle to hold rolls of different widths. Remove the blue paper stop
from the end of the spindle.

)
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3. If your roll has a three-inch cardboard core, ensure that the core
adaptors supplied with the printer have been installed.

4. Ifthe roll is long; rest the spindle horizontally on a table and load the
roll on the table.

_‘{?'_ Tip  You may need two people to handle a large roll.

=N
s

5. Slide the new roll onto the spindle. Make sure the paper type is oriented
as shown. If it is not, remove the roll, turn it 180 degrees and slide it
back on to the spindle. There are labels on the spindle showing the
correct orientation.

I_%q/r NOTE From the back of the printer, the blue stopper is insert
- into the right-side holder.
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Ensure both ends of the roll are as close to the spindle stops as
possible.

ENWW Load a roll onto the spindle 11



6. Put the blue paper stop on to the open end of the spindle, and push it
towards the end of the roll.

7. Ensure the blue paper stop is pushed in as far as it goes; until both
ends are against the stoppers.

If you are a regular user of different paper types, you can change rolls more
quickly if you preload rolls of different paper types on different spindles.
Extra spindles are available for purchase, see Accessories on page 43.

Load a roll into the printer

There are two ways to load a roll. The easy loading procedure is
recommended.

CAUTION To start these procedures you must have a roll loaded
on the spindle. See Load a roll onto the spindle on page 9.

Easy loading procedure

1. Check that you are using the correct spindle for your type of paper,
see Choose which spindle to use on page 9.
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2. Standing behind the printer, rest the spindle's black end on the left side
roll holder. Do not put the end completely into the roll holder.

3. Rest the blue end of the spindle on the right side roll holder. If you are
loading the gray spindle, ensure the rounded side of the spindle top is
resting on the roll holder.

Paper handling

ENWW Load a roll into the printer 13



5. If the edge of the roll is torn (sometimes due to tape used to hold end
of the roll) or not straight, pull paper slightly beyond the cutting groove
and use a cutter to cut a straight edge.

CAUTION Cut the paper as straight as possible, as uneven
paper does not load correctly.

6. Insert the edge of the paper into the feeder.

WARNING! Do not push your fingers inside the printer's paper
path, the results may be painful.
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7. Roll the spindle into the feeder until you feel resistance. The printer
detects the paper and feed it automatically into the printer.

U

8. Once the paper is fed into the printer, the front-panel display asks if
you are loading a roll or a sheet. Select Roll with the Up and Down
keys and press OK.

9. Select your paper category and type.

Select paper category

M Bond and Coated Faper
Photo Faper

Proofing Paper
EFine Art Material
Film

M Technical Paper
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_“{?'_ Tip If you have loaded a paper type whose name does not

-2+~ appear in the paper list (neither in the driver nor in the front
panel), you can choose a generic paper name instead. For
example, if you are loading HP Aquarella Art Paper or Epson
Smooth Fine Art Paper, and you don't find the exact name in
the paper list, you can choose Fine art paper.

10. The printer checks the alignment and measures the width.

11. Look at the front panel; you may find some instructions there.

ENWW Load a roll into the printer 15



12. When the roll is aligned, the front panel displays the Ready message
and the printer is ready to print. If the role is not aligned, follow the
instructions on the front-panel display.

13. Ifthe paperisloose on the roll, lightly rewind from the end of the spindle
until tight.

199 .
E/f’ NOTE If you have an unexpected issue at any stage of the paper
- loading process, see Using your printer on DVD.

:{P Tip  When prints fall into the basket, they can be torn or get ink

- ¥~ marks from other prints. To avoid this, catch your prints as they are
cut from the roll and do not stack prints in the basket or turn off the
automatic cutter, see Using your printer on DVD, and use the Form
feed and cut key to release your print.

Paper menu procedure
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As an alternative you can use the paper menu to start the paper loading
process.

1. Follow steps one through five of the Easy loading procedure
on page 12.

2. Pressthe Menu key to return to the main menu, select the Paper menu

icon .

16 Chapter 3 Paper handling ENWW



3. Select Paper load.

Faper menu
Faper load

@ Unload paper
mView loaded paper
® Faper types list

4. Select Load roll.

Faper load
wmLoad roll

mLoad sheet
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5. Select your paper category and type.

select paper category

B Bond and Coated Faper
Fhoto Faper

Proofing Paper

B Fine Art Material
Film

B Technical Faper

:{P: Tip If you have loaded a paper type whose name does not

-~ appear in the paper list (neither in the driver nor in the front
panel), you can choose a generic paper name instead. For
example, if you are loading HP Aquarella Art Paper or Epson
Smooth Fine Art Paper, and you don't find the exact name in
the paper list, you can choose Fine art paper.

6. Continue with step six of the easy loading process, skipping steps eight
and nine.

:{'?: Tip  When prints fall into the basket, they can be torn or get ink

-5+ marks from other prints. To avoid this, catch your prints as they are
cut from the roll and do not stack prints in the basket or turn off the
automatic cutter, see Using your printer on DVD, and use the Form

feed and cut key to release your print.
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Unload a roll

Before unloading a roll, check whether there is paper on the roll or if the
roll is out of paper, and follow the appropriate procedure as described
below.

18 Chapter 3 Paper handling ENWW



Unload paper key procedure with paper on the roll

If there is paper on the roll, use the following procedure.

1.
2.
3.

4,

Press the Unload paper key on the front panel.

When prompted by the front-panel display, lift the blue lever on the left.

When prompted by the front-panel display, lightly rewind the paper
from the end of the spindle until removed from the printer.

When prompted by the front-panel display, lower the blue lever.

Paper menu procedure with paper on the roll

ENWW

If there is paper on the roll, you can also start the process from the paper
menu in the front panel's main menu.

1.

Press the Menu key to return to the main menu, select the Paper menu

icon .

Select Unload paper.

Faper menu
FPaper load

» Unload paper

»iew loaded paper

H Change loaded paper type
® Paper types list

Continue from step two of the Unload paper key process.

Unload a roll

19
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Roll out of paper procedure

If the end of the paper is no longer attached to the roll use the following
procedure.

1. If you have already started the unload process, press the Cancel key
on the front panel to cancel that procedure.

2. Liftthe blue lever on the left. If the front panel displays a warning about
the lever, ignore it.

3. Pull out the paper from the printer. Pull from wherever the paper is
accessible; the back of the printer is recommended.

Lower the blue lever.

If the front panel displays a warning message, press the OK key to
clear it.

Load a single sheet

20

There are two ways to load a sheet. The easy loading procedure is
recommended.

A CAUTION Any loaded roll or sheet must be unloaded before
loading a sheet, see Unload a roll on page 18, and Unload a single
sheet on page 27.

A WARNING! For sheets thicker than 0.5mm, you must have space
behind the printer equal to the length of the sheet.

Chapter 3 Paper handling ENWW



Easy loading procedure

1. Standing in front of the printer, open the sheet tray. If the sheet is long,
extend the right extension. If the sheet is also wide extend the left

extension.
_‘QI?'_ Tip If the tray is difficult to open, try opening from behind the
+ S~ printer.

999 . .
E/r NOTE The extensions are seven cm and snap in place.
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2. Insert the sheet into the feeder. Load your sheet aligned with the load
line and insert until the paper will not continue, with thicker sheets you
feel resistance. The printer detects the sheet in three seconds. A
countdown begins on the front-panel display.

WARNING! Take care not to push your fingers inside the
printer's paper path, the results may be painful.

3. After the countdown, the paper feeds into the printer. Guide the sheet
into the printer; this is especially important with thicker papers.

4. The front-panel display asks if you are loading a roll or a sheet.
Select Sheet with the Up and Down keys.
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5. Enter your paper category and type.

select paper category

M Bond and Coated Faper
Photo Faper

Proofing Paper
EFine Art Material
Film

ETechnical Paper

:{2'_ Tip If you have loaded a paper type whose name does not

+ s+ appear in the paper list (neither in the driver nor in the front
panel), you can choose a generic paper name instead. For
example, if you are loading HP Aquarella Art Paper or Epson
Smooth Fine Art Paper, and you don't find the exact name in
the paper list, you can choose Fine art paper.
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6. The printer checks the alignment and measures the sheet.

r_'f] NOTE Depending on the length of the sheet, it feeds out the
front of the printer.

7. If the paper has been loaded successfully, the front panel displays
the Ready message and the printer ready to print. If the paper is not
straight, follow the instructions on the front-panel display.

E% NOTE When correctly loaded, the sheet is in the back of the printer.

NOTE If you have an unexpected problem at any stage of the paper
loading process, see Using your printer on DVD.

Paper menu procedure

As an alternative you can use the paper menu to start the paper loading
process

1. Perform step one of the easy loading procedure.
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2. Press the Menu key to return to the main menu and select the Paper
menu icon .

Main Menu

@)

Vs
-

O
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Faper menu

3. Select Paper load.

Faper menu
Paper load

m Unload paper
mView loaded paper
® Paper types list
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Select Load sheet.

Paper load

W Load roll
m Load sheet

Select your paper category and type.

Select paper cateqory

B Bond and Coated Paper
FPhoto Faper

H Proofing FPaper
HFine Art Material
HFilm

H Technical Faper

:Q: Tip If you have loaded a paper type whose name does not
+ 5~ appear in the paper list (neither in the driver nor in the front
panel), you can choose a generic paper name instead. For
example, if you are loading HP Aquarella Art Paper or Epson
Smooth Fine Art Paper, and you don't find the exact name in
the paper list, you can choose Fine art paper.

Continue with step two of the easy loading procedure, skipping steps
four and five.

Chapter 3 Paper handling ENWW



Unload a single sheet

To unload a single sheet after printing, you can simply pull the sheet free
from the front of the printer. To unload a sheet without printing, use the
Unload paper key or the paper menu procedure.

Unload paper key procedure
1. Press the Unload paper key on the front panel.

2. The sheet unloads out the front of the printer, either catch it manually
or allow it to fall in the basket.

Paper menu procedure
You can also unload a sheet from the paper menu.
1. Press the Menu key to return to the main menu and select the Paper

menu icon .

Main Menu
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Faper menu
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28

2. Select Unload paper. The sheet unloads out of the front of the printer,
either catch it manually or allow it to fall in the basket.

Faper menu
Paper load

= Unload paper

»iew loaded paper

E Change loaded paper type
E Paper types list
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Printing

Select print quality

ENWW

The printer has various print-quality options because best-quality printing
requires some loss of speed, while fast printing implies some reduction in
print quality.

Therefore, the standard print-quality selector is a slider that allows you to
choose between quality and speed.

Alternatively, you can select from the custom options: Best, Normal,

and Fast. There are also two supplementary custom options that may have
an effect on print quality: Maximum detail and More passes. See Using
your printer on DVD.

E’/}’ NOTE In the Windows driver dialog, the rendering resolution for
= your job is displayed in the Custom Print Quality Options dialog box.
In the Mac OS Print dialog, it is displayed in the Summary panel.

You can select print-quality options in the following ways:

e Inthe Windows driver dialog: go to the Paper/Quality tab and look
at the Print Quality section. If you select Standard Options, you will
see a simple slider with which you can select speed or quality. If you
select Custom Options, you will see the more specific options
described above.

e Inthe Mac OS Print dialog: go to the Paper Type/Quality panel and
select Paper. If you select Standard quality options, you will see a
simple slider with which you can select speed or quality. If you
select Custom quality options, you will see the more specific options
described above.

Using the front panel: select the Setup menuicon , then Printing
preferences > Print quality. This option is available only with the HP-
GL/2 Upgrade.

%/r NOTE If the print quality is set from your computer, it overrides
- the print-quality setting in the front panel.
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I%’//r NOTE You cannot change the print quality of pages that the printer
— is already receiving or has already received (even if they have not
started to print yet).

Select paper size

The paper size can be specified in the following ways.

I%’//r NOTE The paper size specified here should be the paper size in

— which the document was created. It is possible to rescale the
document to a different size for printing. See Using your printer on
DVD.

e In the Windows driver dialog: select the Paper/Quality tab, then
Document Size.

e Inthe Mac OS Page Setup dialog: select your printer in the Format
for popup menu, then Paper Size.

Using the front panel: select the Setup menuicon , then Printing
preferences > Paper > Select paper size. This option is available
only with the HP-GL/2 Upgrade.

r_i’//r NOTE If the paper size is set from your computer, it overrides
~ the paper size setting in the front panel.

To choose a non-standard paper size not shown in the list of paper sizes:
e Under Windows, there are two different ways:

e In the driver dialog, select Custom from the paper size list in
the Paper/Quality tab, then specify the paper dimensions, then
click Save to save your new paper size. To see your new custom
size in the list of custom sizes, you need to exit the printer
properties, then reenter them and use the More button.

e From the Start menu, select Printers and Faxes, then from the
File menu select Server Properties. In the Forms tab, check
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the Create a new form box, specify the name and dimensions of
the new form, then click Save Form.

Under Mac OS X 10.4, select Paper Size > Manage Custom Sizes
in the Page Setup dialog.

Under Mac OS X 10.2 or 10.3, select Settings > Custom Paper
Size from the Page Setup dialog.

Select margins options

ENWW

By d

efault, the printer leaves a 5 mm margin between the edges of your

image and the edges of the paper (17 mm at the foot of a sheet of paper).

How

You

I%j//r

ever, you can change this behavior in several ways.

In the Windows driver dialog: select the Paper/Quality tab and then
the Layout button.

In the Mac OS Print dialog: select the Paper Type/Quality panel and
then Layout.

will then see at least some of the following options.

NOTE Under Mac OS, the available margins options depend on
the paper size selected in the Page Setup dialog. For instance, for
borderless printing you must select a paper size name that includes
the words “no margins”.

Standard. Your image will be printed on a page of the size you have
selected, with a narrow margin between the edges of the image and
the edges of the paper. The image should be small enough to fit
between the margins.

Oversize. Your image will be printed on a page slightly larger than the
size you have selected. If you cut off the margins, you will be left with
a page of the size you selected, with no margins remaining between

your image and the edges of the paper.

Clip Contents By Margins. Your image will be printed on a page of

the size you have selected, with a narrow margin between the edges
of the image and the edges of the paper. In this case, if the image is

the same size as the page, the printer assumes that the extreme edges
of the image are either white or unimportant, and do not need to be
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printed. This may be useful when your image already contains a
border.

e Borderless. Yourimage will be printed on a page of the size you have
selected, with no margins. The image is slightly enlarged to ensure
that no margin is left between the edges of the image and the edges
of the paper. If you select Automatically by Printer, this enlargement
is done automatically. If you select Manually in Application, you must
select a custom page size slightly larger than the page on which you
intend to print. See also Using your printer on DVD.

Print with shortcuts

The printer driver provides many options that can be set to different values
when printing a particular job. A printing shortcut stores the values of all
these options that are appropriate for a particular kind of job, so that you
can set them all with a single click. Some settings (such as paper size,
paper source, and orientation) may be overridden by the values provided
by your application.

To use a shortcut, select the Printing Shortcuts tab in the Windows driver
dialog.

I%’//r NOTE Shortcuts are available only under Windows.
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& Hp Designjet Z2100 44in Photo Printing Preferences

Advanced | Pinting Shartouts | Paper/Quality | Features || Color | Services|

Selsct the printing shorteut for this print job.

Printing shartcut:
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[ Show preview before printing
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Document size:
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Ojientation:
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Speed Qualty
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7 [1/2] The custom paper type list of ICC Profiles have been updated |4 -
[’ﬂ] ! in the printer. Launch the Printer Uity HP' E asy Printer Care to A~
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You can see a list of available shortcuts; select the one that matches the
kind of job you want to print.

The driver options are now adjusted to suit your job. You can either print
immediately, or examine the settings to check that you agree with them. If
you like, you can select a shortcut and then change some of its settings
manually.

:{P'_ Tip Check at least the settings that you can see in the Printing
-5+ Shortcuts tab: the document size, orientation, etc.

The Factory Defaults shortcut contains the printer's default settings. When
you click on it, it sets all options to their default values.

Printing shortcuts can be customized to your particular needs. To create
your own shortcut:

1. Select the shortcut that comes closest to satisfying your requirements.
2. Change any value in the Printing Shortcuts tab and/or other tabs.
3. Save the new printing shortcut.

If you decide later that you no longer want a shortcut, you can delete it.
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Preview a print

Previewing a print on the screen allows you to check the layout of the print
before printing, which may help you to avoid wasting paper and ink on a
bad print.

e To preview a print under Windows, you have two options:
e Use your application's print preview option.

e Check the Show preview before printing option, which you can
find in the driver's Printing Shortcuts tab, Paper/Quality tab,
and Features tab. The preview is shown before printing; you can
check the print settings and the layout of the image, and then
click Print to proceed with printing or Cancel to cancel the job.

& HP ignjet 72100 44in Photo - Dsk - Untitled-1

@ |olglg

i || cwee DR D |

Page 1 of 1 page(s) 55 dpi

e To preview a print under Mac OS, you have three options:
e Use your application's print preview option.

e Click the Preview button at the bottom of the Print dialog box. This
is the basic print preview provided by Mac OS.
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e Click the PDF button at the bottom of the Print dialog box, then
click HP Print Preview. This provides a preview with more
features, such as the ability to change paper size, paper type, and
print quality, and to rotate the image. See below:

HP Print Preview File Edit View Go Window

8066 * HP Designjet Z2100 44in Photo [25F877] Print Preview - red-canoes-mts_TWBL.tif =
= o Q D = h
B e ¥

Drawer Zoom In Zoom Out Actual Size  Zoom Hide Settings

b, A Print Settings

paper type HP Premium In
@ color mode Use Adobe RG...

quality eptions Standard  +
—_—

. nd

Speed Quality

© source Roll 3
remove )

top/bottom :
blank areas 2
v Layout =
© papersize A4 %
20995 20.70cm
rotate by 90 [
degrees
scale 100%
scale to fit ]
center image ¥
U
horizontal 0 D oam
vertical 0 S m
¥ Constraints & Device Statws (1) =

Selected paper type (HP Premium

Instant-dry Photo Gloss) not available
@ in current paper source (HP Super

Heavyweight Plus Matte Paper).

Please verify your printer setup.

v Conceptual Preview

Printed an: 20.99 x 28.70 cm

! Soft proof ( Reset All Settings ) ( cancel ) (" Print )

I%’/r NOTE HP Print Preview is not available if you are using
— Adobe InDesign, Adobe lllustrator, Adobe Reader, or
Apple Aperture.
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5 Color management

Color calibration

Color calibration enables your printer to produce consistent colors with the
particular printheads, inks, and paper type that you are using, and under
your particular environmental conditions. After color calibration, you can
expect to get identical prints from any two different printers situated in
different geographical locations.
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Calibration should be done in any of the following circumstances:
e Whenever a printhead is replaced

e Whenever a new paper type is introduced that has not yet been
calibrated with the current set of printheads

e Whenever a certain amount of printing has been done since the last
calibration

e Whenever the printer has been turned off for a long period of time

e Whenever the environmental conditions (temperature and humidity)
change significantly

The printer usually reminds you with an alert whenever you need to perform
color calibration, unless you have disabled the alerts. However, if the
environmental conditions change, the printer will not be aware of it.

You can check the color calibration status of the currently loaded paper at
any time by pressing the View loaded paper key on the front panel. The
status may be one of the following:

e PENDING: the paper has not been calibrated.

I%’//r NOTE Whenever you update the printer's firmware, the color
calibration status of all papers is reset to PENDING.

e OBSOLETE: the paper has been calibrated, but the calibration is now
out of date for one of the reasons mentioned above, and should be
repeated.

o DONE: the paper has been calibrated, and the calibration is up to date.
e DISABLED: this paper cannot be calibrated.
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E’/}’ NOTE Color calibration cannot be performed on plain paper,
= nor on any kind of transparent material.

You can also check the color calibration status by using HP Easy Printer
Care (Windows) or HP Printer Utility (Mac OS).
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You should calibrate a paper type before creating its color profile; however,
you can later recalibrate without needing to recreate the color profile.

You can start color calibration in the following ways:
e From the printer alert that recommends calibration.
e From the HP Color Center: select Calibrate Your Printer.

e From the front panel: select the Image Quality Maintenance menu icon

, then Calibrate color.

The calibration process is fully automatic and can be performed unattended
after you have loaded paper of the type you wish to calibrate—which should
be A4, Letter, or any larger size.
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The process takes about 8—10 minutes and consists of the following steps.

1. A calibration test chart is printed, which contains patches of each ink
used in your printer.
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2. The test chart is allowed to dry for a period of time that depends on
the paper type, so that the colors have time to stabilize.

3. The test chart is scanned and measured using the HP Embedded
Spectrophotometer.

4. From the measurements made by the spectrophotometer, the printer
calculates the necessary correction factors to apply for consistent color
printing on that paper type. It also calculates the maximum amount of
each ink that can be applied to the paper.
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6 Maintaining the printer

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you
regularly touch as part of normal operation with a damp sponge or a soft
cloth and a mild household cleaner such as non-abrasive liquid soap.

A WARNING! To avoid an electric shock, make sure that the printer
is turned off and unplugged before you clean it. Do not let water get
inside the printer.

A CAUTION Do not use abrasive cleaners on the printer.

Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is
required. However, in order to maintain the best print quality, replace a
cartridge when it reaches its expiration date. The printer's front panel
notifies you when any cartridge reaches its expiration date.
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You can also check a cartridge's expiration date at any time: see Using
your printer on DVD.

Update the firmware

The printer's various functions are controlled by software that resides in the
printer, otherwise known as firmware.

From time to time firmware updates will be available from Hewlett-Packard.
These updates increase the printer's functionality and enhance its features.
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Firmware updates can be downloaded from the Internet and installed in
your printer in the following ways; you can choose whichever you find most
convenient.

e Using HP Easy Printer Care under Windows, select your printer, the
Support tab, and then Firmware Update.

e Using HP Printer Utility under Mac OS, select Support and then
Firmware Update.

e Using your printer's Embedded Web Server, select the Setup tab and
then Firmware update.

In each case, follow the instructions on your screen to download the
firmware file and store it on your hard disk. Then select the downloaded file
and click Update.

If you experience very slow progress while uploading the firmware file to
the printer, the reason could be that you are using a proxy server. In that
case, try bypassing the proxy server and accessing the Embedded Web
Server directly.
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e InInternet Explorer 6 for Windows, go to Tools > Internet Options
> Connections > LAN Settings, and check the Bypass proxy server
for local addresses box. Alternatively, for more precise control, click
the Advanced button and add the printer's IP address to the list of
exceptions, for which the proxy server is not used.

e In Safari for Mac OS, go to Safari > Preferences > Advanced and
click the Proxies: Change Settings button. Add the printer's IP
address or its domain name to the list of exceptions, for which the proxy
server is not used.

The firmware includes a set of the most commonly used paper profiles.
Extra paper profiles can be downloaded separately; see Using your
printer on DVD.
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7

Accessories

How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your

printer:

e Visit http://www.hp.com/go/designjetz2100 order/ on the Web.

e Contact HP Support (see Contact HP Support on page 63).

The rest of this chapter lists the available supplies and accessories, and

their part numbers.

Order ink supplies

ENWW

The following ink supplies can be ordered for your printer.

Table 7-1 Ink cartridges

Cartridge Part number
HP 70 Matte Black 130 ml Ink Cartridge C9448A
HP 70 Photo Black 130 ml Ink Cartridge C9449A
HP 70 Light Gray 130 ml Ink Cartridge C9451A
HP 70 Cyan 130 ml Ink Cartridge C9452A
HP 70 Magenta 130 ml Ink Cartridge C9453A
HP 70 Yellow 130 ml Ink Cartridge C9454A
HP 70 Light Magenta 130 ml Ink Cartridge C9455A
HP 70 Light Cyan 130 ml Ink Cartridge C9390A
HP 70 Matte Black 130 ml Ink Cartridge Twin Pack CB339A
HP 70 Photo Black 130 ml Ink Cartridge Twin Pack CB340A
HP 70 Light Gray 130 ml Ink Cartridge Twin Pack CB342A
HP 70 Cyan 130 ml Ink Cartridge Twin Pack CB343A
HP 70 Magenta 130 ml Ink Cartridge Twin Pack CB344A
HP 70 Yellow 130 ml Ink Cartridge Twin Pack CB345A

How to order supplies and accessories
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http://www.hp.com/go/designjetz2100_order/

S9110SS320Yy

Table 7-1 Ink cartridges (continued)

Cartridge Part number
HP 70 Light Magenta 130 ml Ink Cartridge Twin Pack CB346A
HP 70 Light Cyan 130 ml Ink Cartridge Twin Pack CB351A

Table 7-2 Printheads

Printhead Part number
HP 70 Matte Black & Cyan Printhead C9404A
HP 70 Light Magenta & Light Cyan Printhead C9405A
HP 70 Magenta & Yellow Printhead C9406A
HP 70 Photo Black & Light Gray Printhead C9407A

Order paper

The following paper categories are currently available for use with your

printer.

e HP Photographic Paper

e HP Fine Art Printing Material

e HP Proofing Paper

e HP Banner and Sign Material

e HP Backlit Material

e HP Self-Adhesive Material and Laminate
e HP Bond and Coated Paper

Specific paper types are likely to change over the course of time. For full
details and the latest information, see http://www.hp.com/go/designjet/

supplies/.
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Non-recommended paper types

In many cases, paper types that are not supported by HP may nevertheless
be usable with your printer. However, the following paper types are unlikely
to give satisfactory results:

e Photo paper that swells
e Brochure paper
Order accessories

The following accessories can be ordered for your printer.

Name Product number
HP Designjet Z2100 24in Stand (Asia only) Q6663A
HP-GL/2 Upgrade Q6692A
EFI Designjet Edition 5.1 for HP XL International Q6643D
EFI Designjet Edition 5.1 for HP XL Japan Q6644D
HP Advanced Profiling Solution Q6695A
HP Jetdirect 635n IPv6/IPsec Print Server J7961G
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8 Troubleshooting paper issues

The paper has jammed

When a paper jam occurs, you normally see the Possible paper jam
message in the front-panel display.

1. Power off the printer at the front panel and also switch it off at the rear.
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2. Open the window.
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3. Try to move the printhead carriage out of the way.

4. Lift the blue lever as far up as it will go.
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ENWW

5.

6.

Carefully remove any of the jammed paper that you can lift up and out
from the top of the printer.

Standing behind the printer, rewind the roll or pull the cut sheet from
the printer. If you cannot see the paper, return to the front of the printer
and remove it from the output tray.

WARNING! Do not move the paper sideways, as it could
damage the printer.
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7. Carefully remove all small pieces of paper.

8. Lower the blue lever.

9. Close transparent window.
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10. Switch on the printer.
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11. Reload the roll, or load a new sheet. See Load a roll into the printer or
Load a single sheet in Using your printer.

r_f’//r NOTE If you find that there is still some paper causing an
= obstruction within the printer, restart the procedure and carefully
remove all pieces of paper.
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9 Troubleshooting print-quality issues

General advice

When you have any print-quality problem:

To achieve the best performance from your printer, use only genuine
manufacturer's supplies and accessories, whose reliability and
performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended
papers, see Order paper on page 44.

Make sure that the paper type selected in the front panel is the same
as the paper type loaded into the printer. To check this, use the View
loaded paper key on the front panel. At the same time, check that the
paper type has been calibrated. Also make sure that the paper type
selected in your software is the same as the paper type loaded into
the printer.

CAUTION If you have the wrong paper type selected, you
could experience poor print quality and incorrect colors, and
perhaps even damage to the printheads.

Check that you are using the most appropriate print-quality settings for
your purposes (see Printing on page 29). You are likely to see lower
print quality if you have moved the print-quality slider to the 'Speed'
end of the scale, or set the custom quality level to Fast.

Check that your environmental conditions (temperature, humidity) are
in the recommended range. See Using your printer on DVD.

Check that your ink cartridges and printheads have not passed their
expiration dates: see Maintain the ink cartridges on page 41.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color
may vary):
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Check that the paper type you have loaded corresponds to the paper
type selected in the front panel and in your software. To check on the
front panel, use the View loaded paper key.

Check that you are using appropriate print-quality settings for your
purposes (see Printing on page 29). In some cases, you can overcome
a print-quality problem merely by selecting a higher print-quality level.
For instance, if you have set the Print Quality slider to Speed, try
setting it to Quality; if you have already set it to Quality, try selecting
custom options and then More Passes. If you change the print-quality
settings, you may wish to reprint your job at this point in case the
problem has been solved.

Print the Image Diagnostics Print. See Using your printer on DVD.

If the printheads are working correctly, go to the front panel and press
the View loaded paper key to see the paper advance calibration status.
If the status is RECOMMENDED, you should perform paper advance
calibration: see Using your printer on DVD.

If the problem persists despite all the above actions, contact your customer
service representative for further support.

Chapter 9 Troubleshooting print-quality issues ENWW



The whole image is blurry or grainy

ENWW

b

Check that the paper type you have loaded corresponds to the paper
type selected in the front panel and in your software. To check on the
front panel, use the View loaded paper key.

Check that you are printing on the correct side of the paper.

Check that you are using appropriate print-quality settings (see
Printing on page 29). In some cases, you can overcome a print-quality
problem merely by selecting a higher print-quality level. For instance,
if you have set the Print Quality slider to Speed, try setting it to
Quality; if you have already set it to Quality, try selecting custom
options and then More Passes. If you change the print-quality
settings, you may wish to reprint your job at this point in case the
problem has been solved.

Go to the front panel and select the Ink menu icon , then
Printhead information to see the printhead alignment status. If the
status is PENDING, you should align the printheads. See Using your
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printer on DVD. After alignment, you may wish to reprint your job in
case the problem has been solved.

5. Go to the front panel and press the View loaded paper key to see the
paper advance calibration status. If the status is RECOMMENDED,
you should perform paper advance calibration: see Using your
printer on DVD.

If the problem persists despite all the above actions, contact your customer
service representative for further support.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:

1. Check that the paper type you have loaded corresponds to the paper
type selected in the front panel and in your software. To check on the
front panel, use the View loaded paper key. At the same time, check
the color calibration status. If the status is PENDING or OBSOLETE,
you should perform color calibration: see Color calibration
on page 37. If you have made any changes, you may wish to reprint
your job in case the problem has been solved.

Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see
Printing on page 29). If you have selected the Speed or Fast options,
you may not get the most accurate colors. If you change the print-
quality settings, you may wish to reprint your job at this point in case
the problem has been solved.
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4. If you are using Application Color Management, check that the color
profile you are using corresponds to the selected paper type and print-
quality settings. If you have doubts about which color settings to use,
see Color management on page 37. If you need to create a color
profile, see Using your printer on DVD.

5. Ifthe problem consists of color differences between your print and your
monitor, please follow the instructions in the “How to calibrate your
monitor” section of the HP Color Center. At this point, you may wish
to reprint your job in case the problem has been solved.

6. Print the Image Diagnostics Print. See Using your printer on DVD.

If the problem persists despite all the above actions, contact your customer
service representative for further support.

Color accuracy using EPS or PDF images in page layout applications

Page layout applications such as Adobe InDesign and QuarkXPress do not
support color management of EPS, PDF, or grayscale files.

If you have to use such files, try to ensure that the EPS, PDF, or grayscale
images are already in the same color space that you intend to use later on
in Adobe InDesign or QuarkXPress. For instance, if your final goal is to print
the job in a press that follows the SWOP standard, convert the image into
SWOP when you create it.

The image is clipped

Clipping normally indicates a discrepancy between the actual printable
area on the loaded paper and the printable area as understood by your
software. You can often identify this kind of problem before printing by

previewing your print (see Preview a print on page 34).

e Check the actual printable area for the paper size you have loaded.
printable area = paper size — margins

e Check what your software understands to be the printable area (which
it may call "printing area" or "imageable area"). For example, some
software applications assume standard printable areas that are larger
than those used in this printer.

e If you have defined a custom page size with very narrow margins, the
printer may impose its own minimal margins, clipping your image
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slightly. You may want to consider using a larger paper size, or
borderless printing (see Select margins options on page 31).

e If your image contains its own margins, you may be able to print it
successfully by using the Clip Contents by Margins option (see
Select margins options on page 31).

e If you are trying to print a very long image on a roll, check that your
software is capable of printing an image of that size.

e You may have asked to rotate the page from portrait to landscape on
a paper size that is not wide enough.

e If necessary, reduce the size of the image or document in your
software application, so it fits between the margins.

There is another possible explanation for a clipped image. Some
applications, such as Adobe Photoshop, Adobe lllustrator, and
CorelDRAW, use an internal 16-bit coordinate system which means that
they cannot handle an image of more than 32,768 pixels. If you try to print
an image larger than this from these applications, the bottom of the image
will be clipped. In this case, the only way to print the whole image is to
reduce the resolution so that the whole image requires fewer than 32,768
pixels. The Windows driver dialog includes an option called 16-bit App.
Compatibility, which can be used to reduce the resolution of such images
automatically. You can find this option in the Advanced tab, under
Document Options > Printer Features.
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10 Front-panel error messages

ENWW

Occasionally you may see one of the following messages appear on the

front-panel display. If so, please follow the advice in the Recommendation

column.

If you see an error message that does not appear here, and you feel in
doubt about the correct response, contact HP Support. See Contact HP

Support on page 63.

Table 10-1 Text messages

Message

Recommendation

[Color] cartridge has expired

Replace the cartridge. See Using your printer on
DVD.

[Color] cartridge is missing

Insert a cartridge of the correct color. See Using
your printer on DVD.

[Color] cartridge is out of ink

Replace the cartridge. See Using your printer on
DVD.

[Color] printhead #[n] error: not present

Insert the correct printhead. See Using your
printer on DVD.

[Color] printhead #[n] error: please remove

Remove the incorrect printhead and insert a new
printhead of the correct type (color and number).
See Using your printer on DVD.

[Color] printhead #[n] error: replace

Remove the non-functional printhead and insert a
new printhead. See Using your printer on DVD.

[Color] printhead #[n] error: reseat

Remove and reinsert the same printhead, or try
cleaning the electrical connections. If necessary,
insert a new printhead. See Using your printer on
DVD.

[Color] printhead #[n] out of warranty

The printhead's warranty has expired, because of
the length of time it has been in operation or
because of the volume of ink used.

[Color] printhead #[n] warranty warning

The printhead's warranty may be invalidated by the
use of the wrong kind of ink.

10 error Restart the printer. If the problem persists, contact
HP Support. See Contact HP Support
on page 63.

10 warning Try again; if the problem persists, contact HP

Support. See Contact HP Support on page 63.
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Table 10-1 Text messages (continued)

Message

Recommendation

Paper advance calibration pending

Perform paper advance calibration. See Using
your printer on DVD.

Paper too small to print paper advance calibration

Unload paper and load larger paper.

Paper too small to scan paper advance calibration

Unload paper and load larger paper.

PDL Error: Ink system not ready

Clean the printheads. See Using your printer on
DVD.

PDL Error: Job clipped

The image is too large for the paper or for the
printer. Load larger paper if possible, or reduce the
image size.

PDL Error: memory full

Restart the printer and try resending the job; if
necessary, reduce the complexity of the job.

PDL Error: out of paper

Load more paper.

PDL Error: parsing error

The print job is unintelligible to the printer. Try to
recreate and resend it. Check your cable
connections.

PDL Error: print mode error

The paper type or print quality specified for the job
are incorrect. Change the loaded paper type or the
print settings.

PDL Error: printing error

Try sending the job again.

PDL Error: virtual memory full

Restart the printer and try resending the job; if
necessary, reduce the complexity of the job.

Printhead alignment error: paper too small

Unload paper and load larger paper.

Replace [color] cartridge

Replace the cartridge. See Using your printer on
DVD.

Reseat [color] cartridge

Remove and reinsert the same cartridge. See
Using your printer on DVD.

Update: failed. Invalid file

Make sure that you have selected the correct
firmware update file. Then try again to perform the
update.

Table 10-2 Numerical error codes

Error code Recommendation
01.0 Restart the printer. If the problem persists, contact HP Support. See Contact
01.1 HP_Support on page 63.
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Table 10-2 Numerical error codes (continued)

Error code Recommendation
01.2
21 Restart the printer. If the problem persists, contact HP Support. See Contact
HP _Support on page 63.
211
22.0
221
22.2
223 @
>
24 ®
»
52:01 The printer needs internal cleaning. See Using your printer on DVD. If the ]
problem persists, contact HP Support. See Contact HP Support £
on page 63. §
S
62 Update your printer's firmware. See Update the firmware on page 41. 2
[)
63 =
2
64 =
o
65 '
67
741 Try the firmware update again. Do not try to use your computer while the
update is in progress. If the problem persists, contact HP Support. See
Contact HP Support on page 63.
79 Restart the printer. If the problem persists, contact HP Support. See Contact
HP Support on page 63.
94 Restart color calibration. See Color calibration on page 37.
94.1
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11 HP Customer Care

Contact HP Support
HP Support is available to you by telephone. What to do before you call:

e Review the troubleshooting suggestions in this guide.
e Review the relevant driver documentation.

e If you have installed third-party software drivers and RIPs, see their
documentation.

e Ifyou call one of the Hewlett-Packard offices, please have the following
information available to help us answer your questions more quickly:

e The printer you are using (the product number and the serial
number, found on the label at the back of the printer)

e Ifthereis an error code on the front panel, note it down; see Front-
panel error messages on page 59

e The printer's Service ID: at the front panel, select the Information

menu icon , then View printer information

e The computer you are using

e Any special equipment or software you are using (for example,
spoolers, networks, switch-boxes, modems, or special software
drivers)

e The cable you are using (by part number) and where you
purchased it

o
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o
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]
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o

I

e The type of interface used on your printer (USB or network)

e The software name and version you are currently using

e If possible, print out the following reports; you may be asked to
fax them to the support center helping you: Configuration, Usage
Report, and “all pages above” from Service Information (see
Using your printer on DVD)
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Telephone numbers

An up-to-date list of HP Support telephone numbers is available on the
Web: please visit http://welcome.hp.com/country/us/en/
wwecontact_us.html. If you have no access to the Web, try one of the
numbers below.

e Algeria: 213 17 63 80

e Argentina: 0 800 777 HP INVENT, local 5411 4778 8380
e Australia: 1310 47

e Austria: 0810 00 10 00

e Bahrain: 800 171

e Belgium: (0) 78 600 600

e Bolivia: 0 800 1110, local 54 11 4708 1600
e Brazil: 0800 157 751, local 55 11 3747 7799
e Canada: 1 800 HP INVENT

e Caribbean: 1 800 711 2884

e Central America: 1 800 711 2884

e Chile: 800 HP INVENT, 123 800 360 999

e China: 800 810 59 59, 10 6564 59 59

e Colombia: 01 8000 51 HP INVENT, local 571 606 9191
e Czech Republic: 420 261 307 310

e Denmark: 70 11 77 00

e Ecuador: 999 119, 1 800 225 528

e Egypt: 202 532 5222

e Finland: 0203 53232

e France: 08 26 10 49 49

e Germany: 0180 52 58 143

e Greece: 210 6073603, 801 11 22 55 47

e Guadaloupe: 0800 99 00 11, 877 219 8791
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Guatemala: 1 800 999 5105, 1 800 711 2884
Hong Kong: 852 3002 8555

Hungary: 06 1 382 1111

India: 1 600 112 267

Indonesia: 350 3408

Ireland: 1 890 946500

Israel: 09 830 4848

Italy: 02 3859 1212

Jamaica: 0 800 711 2884

Japan: software 0120 014121, hardware 0120 742594
Korea: 82 1588 3003

Luxembourg: 27 303 303

Malaysia: 1 800 80 5405

Martinique: 0 800 99 00, 877 219 8671
Mexico: 01 800 472 6684, local 5258 9922
Middle East: 4 366 2020

Morocco: 2240 4747

Netherlands: 0900 1170 000

New Zealand: 09 365 9805

Norway: 800 62 800

Paraguay: 00 811 800, 800 711 2884
Panama: 001 800 711 2884

Peru: 0 800 10111

Philippines: 632 888 6100

Poland: 22 566 6000

Portugal: 213 164 164

Puerto Rico: 1 800 652 6672

Contact HP Support

65

o
S
]

o
S
]
£
]

i)
®
S

(8}

o

I




e RSA: 27 11 258 9301, local 086 000 1030
e Romania: 40 21 315 4442

e Russia: 095 797 3520, 812 3467 997

e Saudi Arabia: 6272 5300

e Slovakia: 2 50222444

e  South Africa: 0800 001 030

e Spain: 902 010 333

e Sweden: 077 130 30 00

e Switzerland: 0848 80 20 20

e Taiwan: 886 2 872 28000

e Thailand: 0 2353 9000

e Tunisia: 71 89 12 22

e Turkey: 216 444 71 71

e UAE: 800 4520, 04 366 2020

e Ukraine: 44 4903520

e United Kingdom: 0870 842 2339

e United States: 1 800 HP INVENT

e Uruguay: 54 11 4708 1600

e Venezuela: 0 800 HP INVENT, local 58 212 278 8000
e Vietnam: 84 8 823 45 30

e West Africa (French): 351 213 17 63 80
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clean the printer 41
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core adaptors 11

E
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error messages, front panel 59

F
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HP Support 63
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image problems
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ink cartridge
maintenance 41
order 43
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load a sheet 20

load roll into printer 12
load roll onto spindle 9

M
margins 31
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order
accessories 45
ink cartridges 43
paper 44
printheads 44

P
page size 30
paper jam 47
paper size 30
paper types 44
preview a print 34
print preview 34
print quality
select 29
print with shortcuts 32
print-quality problems
banding 53
general 53
graininess 55
horizontal lines 53
printer software 4
Printer Utility

access 7

printhead
order 44

R

roll paper
choose spindle 9
load into the printer 12
load onto the spindle 9
unload 18

S

safety precautions 1
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load 20
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switch the printer on/off 5
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